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About This Guide

This document is a quick user guide to getting started with ESP8266. The document is
structured as follows.
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Introduction to the ESP8266 development board —ESP-
LAUNCHER, and how to download firmware to the board and
run it.

Configuring the Development

Chapter 1 g ord— ESP-LAUNCHER.

Compiling the AT application based on ESP8266_NONOS_SDK

Chapter 2 Compiling Applications as example.

Learn More About

Chapter 3 ESP8266_RTOS_SDK More information on ESP8266_RTOS_SDK.

Chapter 4  Debug Methods Common debugging methods and sample codes.
Downloading Firmware into . , .

Chapter 5 Introduction on how to flash firmware with ESP-WROOM-02.

The ESP-WROOM-02

ESP8266-related must-read documents and must-have

Appendix A Learning R r
ppend earning Resources reSOUICEs.

Release Notes

Date Version Release notes
2016.08 V1.0 First release.
2016.11 V14 Added Appendix A—Learning Resources.

Added two Github links of RTOS and non-OS SDK sample

2017.01 Vi.2 code in Appendix A.2 —Must-Have Resources.
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@ 1. Configuring the development board —ESP-LAUNCHER

1. Configuring the development
board —ESP-LAUNCHER

1.1. Hardware Preparation

To get started with developing applications for the ESP8266, hardware and the
corresponding software tools are needed as follows:

¢ One of the following ESP8266 Hardware Development Kit (HDK):
- ESP8266 official development board, ESP-LAUNCHER, as shown in Table 1-1.
- ESP8266 official module, ESP-WROOM-02, as described in Chapter 5.

e PC for programming: Windows XP or Windows 7 OS is recommended, with enough
RAM to run a Linux virtual machine.

e Micro USB cable.

| Notes:

» If users use the third-party development boards or modules that integrate the ESP8266, please use
the development firmware provided by the corresponding manufacturers.
« To purchase ESP-WROOM-02 or ESP-LAUNCHER, please visit Espressif's official online store at:

Table 1-1. The ESP8266 Development Board

ESP-LAUNCHER

e 1 ESP-LAUNCHER
e 1 Micro USB cable

! Notice:

The ESP8266 Wi-Fi module requires 3.3V power supply and may draw a minimum current of 500 mA.

1.2. Software Preparation
e ESP8266 official Flash Download Tool

- Download: http://www.espressif.com/support/download/other-tools

* ESP8266 official SDK
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1. Configuring the development board —ESP-LAUNCHER

- Download SDK: http.//www.espressif.com/support/download/sdks-demos

- The official AT firmware (ESP8266_NONOS_SDK\bin\at) can be downloaded into the
ESP-LAUNCHER by referring to the BIN locations mentioned in the Readme file
which is in the same directory. For instructions on downloading the firmware into the
ESP-LAUNCHER, please refer to Section 1.3.

e PC UART terminal emulator tool
- SecureCRT/minicom is recommended.

- UART tools mentioned above can support the default baud rate of 74880. Note that
certain USB-UART converters may not support all baud rates if users use a third-
party development board.

1.3. Download Firmware into the ESP-LAUNCHER

Espressif

1. Using the ESP8266_NONOS_SDK_V2.0.0_16_07_19 as example. The AT firmware
binaries are located in
ESP8266_NONOS_SDK V2.0.0_16_07_19\ESP8266_NONQOS_SDK\bin.

» BB at
» [ at_sdio
1 blank.bin
b boot_v1.2.bin
' boot_v1.6.bin
b esp_init_data_default.bin

Figure 1-1. ESP8266_NONOS_SDK BIN Folder
2. Settings of the development board, ESP-LAUNCHER.

I
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Figure 1-2. The ESP-LAUNCHER
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1. Configuring the development board —ESP-LAUNCHER

Z

e The switch 1: toggle to the lower side;
e The switch 2: toggle to the lower side;
* The switch 3: toggle to the upper side;
e The pin4: put a jumper cap on the above 2 pins;
e The pin5: put a jumper cap on it.
3. Use micro USB cable to connect the ESP-LAUNCHER to the PC. The UART driver
needs to be installed on the PC.

4. Double-click ESPFlashDownloadTool v3.3.4.exe to run the ESP8266 Flash Download
Tool on the PC.

B3 ESP8266 DOWNLOAD TOOL V3.3.4 -_— a X
SPIDownload | HSPIDownload | RFConfig | MultiDownload
~Download Path Config
© [ 07_19\E5P8266 NONOS_SDK\bin\blank.bin
< [£NONGS S0 bimesp i dte deoin -
© [ 07_19\ESP8266 NONOS_SDK\bin\blank.bin .
© [ 07_19\ESP8266 NONOS_SDK\bin\blankbin .
< (19575285 NONGS SORBimboat 1658
© [sDK\bin\at\1024+1024\user1.2048.new.5.bin.
DeviceMasterKey Folder Path
| |
— SpiFlashConfig ]
Crystalfreq:  Combinein || TASH S8 M= spiautoset
|26M vI W " AMbit [~ DoNotChgBin
~SPI SPEED—— - SP| MODE | { 2Mbit I~ LOCK SETTINGS
& 40MHz & QI0 € 8Mbit P
C 267MHz || Qour || © 16Mbit
¢ 20MHz © DIO € 32Mbit
 80MHz ¢ pour || 16Mbit-Cl
¢ 32Mbit-C1
Download Panel 1
START | sTop | COM: |como ~
BAUD: |1152000 =

Figure 1-3. ESP8266 Flash Download Tool
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@ 1. Configuring the development board —ESP-LAUNCHER

Figure 1-3 uses 16Mbit-C1 (1024+1024 map) flash as an example. The locations of
binaries to be downloaded into are shown in Table 1-2.

Table 1-2. Download AT Binaries for 16 Mbit-C1 Flash Map
BIN Address Description

blank.bin 0x1FB0O00 It initializes RF_CAL parameter area.

It stores the default RF parameter values and has to be

L . downloaded into the flash at least once.
esp_init_data_default.bin  0x1FC000 R )
If the RF_CAL parameter area is initialized, this BIN has to be

downloaded too.

blank.bin OxFEOOO It initializes the user parameter area.
blank.bin Ox1FEOQO It initializes the system parameter area.
boot.bin 0x00000 It is the main program located in \bin\at.
user1.2048.new.5.bin 0x01000 It is the main program located in \bin\at\1024+1024.
—| Notes:

» The SpiFlashConfig and the COM on the ESP8266 Flash Download Tool should be set according to
the actual situation.

= For more information on downloading AT firmware, please refer to documentation ESP8266 AT
Instruction Set.

5. Click the START button and wait for the ESP-LAUNCHER to power up.
6. Power on the ESP-LAUNCHER by toggling the switch 1 in Figure 1-2 to the upper side.

7. The ESP8266 Flash Download Tool will start to download AT firmware into the ESP-
LAUNCHER. The DETECTED INFO area will display information of the flash chip on the
ESP-LAUNCHER.
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1. Configuring the development board —ESP-LAUNCHER

<

~SpiFlashConfig
= . |~ FLASH SIZE —
CrystalFreq : CombineBin ™ SpiAutoSet
|26M vl Default " 4Mbit I~ DoNotChgBin
—SPI SPEED —— ~ SPI MODE — " 2Mbit LOCK SETTINGS
& 40MHz & QIO " 8Mbit ~ DETECTED INFO
~ 26.7MHz ¢ QouT " 16Mbit flash vendor: -
'  32Mbit Alh:FM
" 20MHz " DIO flash devID:
 80MHz ~ DOUT ¢ 16Mbit-C1 4016h
~ 3oMbit.c1 | | QUAD:32Mbit
crystal:
2 Mhz -

~Download Panel 1

o [ap mAC: SE-CF-7F-14-C7-a5
| [sTaMac sccRF1a-c7-8

COM: |COM9

BAUD: |1152000

Figure 1-4. ESP8266 Flash Download Tool - Downloading Firmware

8. After the download is finished, toggle the switch 1 to the lower side to power off the
ESP-LAUNCHER.

~Download Panel 1

2. |AP MAC: 5E-CF-7F-14-C7-45
sk STA MAC: 5C-CF-7F-14-C7-45
e

COM: |COM9

BAUD: 1152000
AERRRRERENEEEEERR RN

Figure 1-5. ESP8266 Flash Download Tool - Finishing downloading Firmware

9. Open the UART tool on PC, set baud rate to 115200, check the New line mode for the
UART tool.
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@ 1. Configuring the development board —ESP-LAUNCHER

Category:
| ;Z?;T Actons Port: COM9 - Flow control
& Terminal Baud rate: 115200| CIoR/DsR
[=)- Emulation [C|RTS/CTS
~Modes Data bits: ] xoNXoF
Iviio parity:
- Mapped Keys L
[=)- Appearance
Category:
= Connection Emulation Modes
H Acti
i Log_on ctions Initial modes Current modes
i ieSerial
£ Terminal ("] cursor key mode ["] cursor key mode
=R E{nulaﬁon Line wrap Line wrap
- Emacs New line mode New line mode
-~ Mapped Keys (@ Numeric keypad (@ Numeric keypad
----- Advanced . e - o
- Appearance () Application keypad () Application keypad

Figure 1-6. UART Emulator Tool on the PC

10.Set the ESP8266 to operation mode by toggling the switch 2 to the upper side. Then
toggle the switch 1 to the upper side to power on the ESP-LAUNCHER.

At first, the PC UART tool will output some garbage characters (which is normal,
because the power-on-default baud rate of ESP8266 is 74880). The PC UART tool will

then output "ready" message, indicating that the ESP-LAUNCHER is running the AT
firmware successfully.

(B 768 217 € Fr qr TU[ B 117 B LIS 700 R 1TEbIE
T€ 1 +blER17 |?7r 1qr 14

ready

AT+GMR

AT version:1.3.0.0(Jul 14 2016 18:54:01)
SDK version:2.0.0 (BS6edbf)

compile time:Jul 19 2016 15:44:22

|OK

Figure 1-7. AT Logs on the UART Tool

11.Input command AT+GMR through the UART tool, and press Enter button. You will get a
response printing the version information of the AT firmware.

For more AT commands and examples, please refer to documents:
ESP8266 AT Instruction Set and ESP8266 AT Command Examples.
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2. Compiling Applications
Compiling Applications

This chapter describes how to compile a program based on the ESP8266_NONOS_SDK,
using the AT demo application provided by Espressif Systems as an example.

N

2.1. Downloading the Virtual Machine

1. PC: Windows XP or Windows 7 OS is recommended.

2. The development environment provided by Espressif Systems is based on Lubuntu. The
Espressif Systems also provides a virtual image of the development environment that
can be run on VirtualBox.

® Download VirtualBox-5.0.16-105871-Win.exe from:

https.//www.virtualbox.org/wiki/Downloads

] Note:

Please choose the correct version of VirtualBox according to the host machine's OS.

® Download ESP8266_lubuntu_20141021.ova from:
Baidu: https.//pan.baidu.com/s/1dEOw8bZ (Password: v81b)

Google: https.//drive.google.com/folderview?
id=0B5bwBE9A5dBXaExvdDEXVFNrUXM&usp=sharing

2.2. Setting up Development Environment

Steps Results

1. Start Windows OS and install the virtual machine.

¢ Double-click
VirtualBox-5.0.16-105871-Win.exe filemm Mzchinemmbiclp

and install VirtualBox. i:w} g v @ s
=5 NOte: . : Welcome to VirtualBox!
VirtualBox has different versions. We are - hmmptzmw
using Windows V.5.0.16 as an R A
example. kL U e e ; @ﬂ ‘
* Double-click Oracle VM N

VirtualBox.exe to run the program
and the system will display the main

menu

) Tip:
ESP8266 virtual machine takes up a lot
of space (RAM). Please make sure the

machine has enough memory to spare.
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Steps Results

2. Set VirtualBox default machine folder.

& VirtualBox - Settings
e Create a new folder, for example, D:
\VM. [l General General
 Select File > Preferences, the & input Fualt Nachine Folder: | : |
Default Machine Folder: D: AWM v
system shows the dialog box « . © Update | |
VRDP Authentication Library: | VBoxhAuth v
 Inthe General tab, set the location @ Lfnguage
for the virtual machine in Default Display
Machine Folder, for example, D: & Network
\VM. D Extensions
( Proxy
S Tip:
ESP8266 virtual machine takes up a lot
of space (RAM). Please make sure the
machine has enough memory to spare. ) =

3. Import the image file.

Appliance to import

(OVF). To continue, select the file to import below.

e Select File > Import Appliance, a

VirtualBox currently supports importing appliances saved in the Open Virtualization Format

. . C:\ESP8266_lubuntu_20141021.
dialog box will show up L — o ovd

¢ Select the image file, for example, C:
\ESP8266_lubuntu_20141021.ova,
and click Next.

e Click Import to confirm the settings.

Expert Mode ] ’

Next

) {

Cancel

4. Create a shared folder.

8/21
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Create a new folder named D:\VM
\share.

Select Machine > Settings >
Shared Folders..., a dialog box will

show up

Select the shared folder in Machine
Folders, for example, D:\VM\share.

. Run the virtual machine.

After importing, a virtual machine
named ESP8266_Ilubuntu shows up

Double-click ESP8266_Ilubuntu or
Start to power on the virtual
machine.

The system shows ESP8266 virtual
machine

If the virtual machine enters idle
mode and is locked, a dialog box as
below “+ will show up, please enter
the password: espressif.

ESP8266 v

~
o ]

Unlock

2. Compiling Applications

@ General
m System
Display
B Storage
& Audio

@ MNetwork
@ Serial Ports
& use

Shared Folders

Shared Folders

Folders List

MName Path Auto-mount  Access @

= Machine Folders -
share D:\WMishare Yes Full <

Double-click LXTerminal to start
compiling applications, for more
details please refer to Chapter 2.3.

[ OK I[ Cancel ]l Help ]

I

@ @ v

New Settings Discard Start

Powered Off

g ’:9 - @l snapshots
n = General = preview i
Name: ESP8266_lubuntu
Operating System: Ubuntu (32-bit)

4| system

Base Memory: 1024 MB

Boot Order: Optical, Hard Disk

Acceleration:  VT-x/AMD-V, Nested
Paging, PAE/NX

ESP8266_lubuntu

1

& pisplay

Video Memory: 12 MB

Remote Desktop Server: Disabled —
Video Capture: Disabled

‘ﬂ Storage

Controller: IDE

IDE Secondary Master: [Optical Drive] Empty
Controller: SATA

SATA Port 0: ESP8266_lubuntu-disk1.vmdk (Normal, 8.00 GB)
~

$ Audio

LXTerminal

) 08 &5 1y 1826 (O
Bo®ya™m@ e ® rgtan

9/21

2017.01



2. Compiling Applications

2.3. Compiling Applications Using ESP8266_NONOS_SDK

1. Start the virtual machine. Run LXTerminal on the desktop of the virtual machine.

2. Copy the ESP8266_NONOS_SDK to be compiled to the shared folder.

Steps

Result

Espressif

Copy ESP8266_NONOS_SDK folder on PC to

the shared directory, for example, D:\VM\share.

Copy ESP8266_NONQOS_SDK\examples\at
folder to the directory D:\VM\share
\ESP8266_NONOS_SDK, as shown in the

figure on the right

Steps

Execute command ./mount.sh in the
[ XTerminal.

Input the password: espressif.
Shared folder mounting is completed.

Open the shared directory

ESP8266_NONOS_SDK in the virtual machine

and confirm if the mounting is successful.

- If successful, the directory contains files as
the figure on the right shows.

- If not, the directory will be empty and you
will need to repeat the above step again.

10/21

> VM > share > ESP8266 NONOS_SDK

File Edit Tabs Help

File Edit
Fl< -

Places

4} Home Folder

B Desktop

i Trash Can
@ Applications

[® Documents

[@ Music
[@ Pictures
[@ Videos

[® Downloads

11items (1 hidden)

N

at

bin
documents
driver_lib
examples
include

Id

lib

tools

. Mount the shared directory to the virtual machine.

Result

ESP8266_NONOS_SDK - + X
View Bookmarks Go Tools Help
> A @ |/home/esp8266/Share/ESP8266_NONOS_SDK M

v Lu de
-

lib

bin documents
d

include

License

.
2
3
°
3

E

tools Makefile

Free space: 192.8 GiB (Total: 394.4 GiB)

2017.01



@ 2. Compiling Applications

4. Change the directory to /share/ESP8266_NONOS_SDK/at in the LXTerminal and
compile it.
Steps Result

B esp8266@esp8266-Vir...P8266_NONOS_SDK/at — + X
e Edit Tabs Help

¢ |n the LXTerminal, change the directory by
executing command: cd /home/esp8266/
Share/ESP8266_NONOS_SDK/at

* Then execute command: ./gen_misc.sh to i :~/Sha 6_NONOS_SDK/at$
start compiling.

e For example, the choices for STEP 1 ~ 5 in the
compilation can be: 1, 1, 2, 0 and 5
respectively.

== Note:
For more details on compiling applications, please refer to ESP8266 SDK Getting Started Guide.

5. After compilation, the binaries generated and their corresponding download addresses
in the flash memory are as follows:

Support boot_v1.4 and +
Generate userl.2048.new.5.bin successfully in folder bin/upgrade.
IERE DA me=m= >0x00000

userl.2048.new.5.bin--->0x01000

= Note:

Users can open /Thome/esp8266/Share/ESP8266_NONOS_SDK/bin/upgrade directory and check the
binaries compiled.

6. The AT binaries generated can be downloaded to the ESP-LAUNCHER (refer to Section
1.3 ) and run.
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@ 3. Learn More About ESP8266_RTOS_SDK

Learn More About
ESP8266 RTOS SDK

3.1. Compiling Application Using ESP8266_RTOS_SDK

1. Download the ESP8266_RTOS_SDK from:
https.//qithub.com/espressif/ESP8266_RTOS SDK
ESP8266_IOT_PLATFORM is a demo application based on ESP8266_RTOS_SDK.
Download from: https.//qithub.com/espressit/ESP8266 10T _PLATFORM

2. Copy ESP8266_IOT_PLATFORM and ESP8266_RTOS_SDK to the PC's shared
folder.

o

Steps Result

e Copy ESP8266_RTOS_SDK and
ESP8266_I0T_PLATFORM folder to the > VM > share
shared folder of the PC, for example, D\VM A
\share.

* As shown in the figure on the right

ESP8266_|OT PLATFORM
ESP8266 RTOS_SDK

3. Start the virtual machine. Run LXTerminal on the desktop of the virtual machine.

Steps Result

e Start ESP8266 virtual machine

[BA &s O

- If the virtual machine is locked, please enter
the password: espressif to unlock it.

e Double-click LXTerminal to start compilation. LXTerminal

EAl & EE T == ) (8
‘ BOF a0 @ @ikt cel
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Steps

Execute command . /mount.sh in the
L XTerminal.

Input the password: espressif.
Shared folder mounting is completed.

Open the shared directory
ESP8266_RTOS_SDK in the virtual machine
and confirm if the mounting is successful.

- If successful, the directory contains files as
shown in the figure on the right

- If not, the directory will be empty, you will
need to repeat the above step again.

Steps

SDK_PATH: the directory of
ESP8266_RTOS_SDK

BIN_PATH: the directory which the binaries are

generated in after compilation

As the figure on the right shows.

Steps

Revise the LINKFLAGS_eagle.app.v6 area in
the ESP8266_IOT_PLATFORM\makefile:

- Delete -Iminic
- Add -Icirom and -Imirom

As the figure on the right shows.

13/21
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. Mount the shared directory to the virtual machine.

Result

File Edit Tabs Help

(] ESP8266_RTOS_SDK -+ x
File Edit View Bookmarks Go Tools Help

[#l € ¥ > A |@ /home/esp8266/Share/ESP8266_RTOS_SDK Yy
Places v = e —— —

G} Home Folder dg ﬂ;l M H

B Desktop bin documents  examples extra_includ

& Trash Can e

[@ Applications

[@ Documents Lg U;l H dg’
@ Music include d lib third_party
[ Pictures

(@ Videos — ‘ = ‘ ‘ = ‘ =

@ Downloads tools LICENSE ~ Makefile ~README.md

12items Free space: 192.7 GiB (Total: 394.4 GiB)

. Set the SDK_PATH and the BIN_PATH in ESP8266_IOT_PLATFORM\gen_misc.sh.

Result

[= gen_misc. shEd

11 export SDK_PATH=~/Share/ESP8266_RTOS_SDK
12 export BIN_PATH=~/Share/ESP8266_RTOS_SDK/bin

. Revise the ESP8266_IOT_PLATFORM\makefile.

Result

LINKFLAGS_eagle.app.v6 \
-L$ (SDK_PATH) /1ib \
-Wl,--gc-sections \
-nostdlib \
-T$(LD_FILE) \
-Wl,--no-check-sections \
-u call_user_start \
-Wl,-static
-Wl,--start-group
-lcirom \
~-lmirom \

2017.01
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3. Learn More About ESP8266_RTOS_SDK

7. Change the directory to /share/ESP8266_IOT_PLATFORM in the LXTerminal, and

compile it.

Steps Result

e |n the LXTerminal, change the directory by B esp8266@esp8266-VirtualBox: ...hare/ESP8266_IOT_PLATFORM — + X
File Edit Tabs Help

executing command: cd /home/esp8266/
Share/ESP8266_I0T_PLATFORM

e Then execute command: ./gen_misc.sh to
start compiling.

== Note:
For more details on compilation, please refer to ESP8266 SDK Getting Started Guide.

8. After compilation, the binaries are generated and the corresponding download
addresses in the flash memory are as follows:

Support boot_v1.4 and +

Generate userl.1024.new.2.bin successfully in BIN_PATH

boot.bin------------ >0x00000

userl.1024 .new.2.bin--->0x01000

-l Note:

You can open /home/esp8266/Share/ESP8266_RTOS_SDK/bin directory and check the binaries
compiled.

9. Download the binaries generated to the ESP-LAUNCHER and run.

-] Note:
The power-on-default baud rate of ESP8266 is 74880 for the ESP-LAUNCHER.

14/21
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@ 3. Learn More About ESP8266_RTOS_SDK

3.2. ESP8266 RTOS SDK Architecture

Application Framework & Service

| Cloud Firmware
‘ Protocol ‘ ‘ Upgrade

Restful Web
Services

A 4

| L HTTP Client |~ HTTP Server J

4

Protocols

ESP
J [ TCP/P Management cJSON

Power J{ mDNS J[ TLS/SSL J{ XML/

RTOS

L Wi-Fi Control Interface
|
\

N W S—

Low Level Control and Physical Abstract Layer

High MAC

Low MAC

Figure 3-1. ESP8266_RTOS_SDK Architecture
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4. Debug Methods
4. Debug Methods

4.1. Debug Methods

4.1.1. Add UART Output Logs
For ESP8266_NONOS_SDK, users can add debug logs as below:

os_printf("SDK version:%s\n", system_get_sdk_version()); ‘

For ESP8266_RTOS_SDK, users can add debug logs as below:

printf("SDK version:%s\n", system_get_sdk_version()); ‘

4.1.2. Debug Fatal Exception

If a fatal exception occurred, UART output logs will be as shown:

Fatal exception (28):

epcl=0x4025bfab, epc2=0x00000000, epc3=0x00000000, excvaddr=0x0000000f, depc=0x00000000

1. Find the corresponding .s file which is generated with the running binaries in the same
directory (ESP8266_SDK\bin).

For example, if running eagle.flash.bin and eagle.iromOtext.bin, the corresponding file
is eagle.s.

2. Locate the address of epc1 (as Ox40XXXXXX) in the .s file to find the target function that
fatal exception occurred.

3. Add logs before and after the target function is called to debug the fatal exception
problem.
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5. Downloading Firmware into the
ESP-WROOM-02

Please follow the steps below to download firmware into ESP-WROOM-02.

1. ESP-WROOM-02 is the official ESP8266 module provided by Espressif Systems. Lead
out the pins of ESP-WROOM-02 as shown in Table 5-1.

Table 5-1. ESP-WROOM-02 Pins

Pin Pin status Figure
EN Pull up
3v3 3.3V power supply (VDD)
1015 Pull down
UART Download mode: pull down;
1oo FLASH Boot mode: floating/pull up
GND GND
RXD UART Download Rx
TXD UART Download Tx, floating/pull up

2. Connect ESP-WROOM-02 to USB-to-TTL converter using Dupont lines as shown in
Figure 5-1.

ESP-WROOM-02

USB-to-TTL converter

V.

3v3

EN

RXD D

QREE
Al [

D RXD

GND GND

| 1015 | | 100 |

Figure 5-1. ESP-WROOM-02 Download Mode
3. Connect the USB-to-TTL converter to the PC.
4. Download firmware to flash with ESP8266 DOWNLOAD TOOL.
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—| Note:

On how to download firmware, please refer to Section 1.3.

5. After downloading, set 100 as floating or pull up and switch ESP-WROOM-02 to
working mode.

6. Power on ESP-LAUNCHER again and the chip will read and run programs from the
flash.

_| Note:

100 is an internal pull-up pin. For more information on ESP-WROOM-02 hardware, please refer to ESP8266
System Description and ESP-WROOM-02 Datasheet.
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Appendix A

Appendix—Learning
Resources

A1l.

Espressif

Must-Read Documents

ESP8266EX Datasheet

Description: This document introduces the specifications of ESP8266EX, including an
overview of the features, protocols, technical parameters and applications. It also
introduces pin layout and the relevant description, as well as major functional modules
and protocols applied on ESP8266EX (CPU, flash and memory, clock, radio, Wi-Fi, and
low-power management). Besides, it provides descriptions of peripheral interfaces
integrated on ESP8266EX, lists the electrical data of ESP8266EX and illustrates the
package details for ESP8266EX.

ESP8266 Hardware Resources

Description: This zip package includes manufacturing specifications of the ESP8266
board and the modules, manufacturing BOM and schematics.
ESP8266 Non-OS SDK loT_Demo Guide

Description: This document provides simple demo implementations of three types of
smart devices: Smart Light, Smart Power Plug, and Sensor Device. It also introduces
the readers to curl toolkits, functions in LAN and WAN.

ESP8266 RTOS SDK Programming Guide

Description: This document provides sample codes based on ESP8266_RTOS_SDK,
including basic examples, networking protocol examples and advanced examples.

ESP8266 AT Command Examples

Description: This document introduces some specific examples on the usage of
Espressif AT commands, including single connection as a TCP client, UDP transmission
and transparent transmission, and multiple connection as a TCP server.

ESP8266 AT Instruction Set

Description: This document provides lists of AT commands based on
ESP8266_NONOS_SDK, including user-defined AT commands, basic AT commands,
Wi-Fi AT commands and TCP/IP-related AT commands. It also introduces the
downloading of AT firmware into flash.

ESP8266 Non-OS SDK API Reference

Description: This document lists ESP8266_NONOS_SDK APIs, provides an overview of
ESP8266_NONOS_SDK and introduces the readers to system APIs, TCP/UDP APIs,

mesh APIs, application specific APIs, definitions and data structures, and APls for
peripheral interfacing.
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http://espressif.com/sites/default/files/documentation/0a-esp8266ex_datasheet_en.pdf
http://espressif.com/en/support/download/documents?keys=ESP8266+hardware+resources
http://www.espressif.com/sites/default/files/documentation/2b-esp8266_non-os_sdk_iot_demo_guide_en.pdf
http://www.espressif.com/sites/default/files/documentation/20a-esp8266_rtos_sdk_programming_guide_en.pdf
http://www.espressif.com/sites/default/files/documentation/4b-esp8266_at_command_examples_en.pdf
http://www.espressif.com/sites/default/files/documentation/4a-esp8266_at_instruction_set_en.pdf
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D)

Appendix A

ESP8266 RTOS SDK API Reference

Description: This document lists ESP8266_RTOS_SDK APIs, including functions for Wi-
Fi related APIs and boot APls, etc.

FAQ

A.2. Must-Have Resources

Espressif

ESP8266 SDKs

Description: This website page provides links to the latest version of ESP8266 SDK and
the older ones.

RTOS Sample Code

Description: This webpage provides the sample code for the commonly used functions.
Non-OS Sample Code

Description: This webpage provides the sample code for the commonly used functions.
ESP8266 Tools

Description: This website page provides links to the ESP8266 flash download tools and
ESP8266 performance evaluation tools.

ESP8266 APK

ESP8266 Certification and Test Guide
ESP8266 BBS

ESP8266 Resources
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http://espressif.com/en/support/download/documents?keys=ESP8266+RTOS+SDK+API+Reference&field_type_tid%5B%5D=14
http://espressif.com/en/support/explore/faq
http://www.espressif.com/en/support/download/sdks-demos?keys=&field_type_tid%5B%5D=14
https://github.com/espressif/esp8266-rtos-sample-code
https://github.com/espressif/esp8266-nonos-sample-code
http://www.espressif.com/en/support/download/other-tools?keys=&field_type_tid%5B%5D=14
http://www.espressif.com/en/support/download/apks?keys=
http://espressif.com/en/support/download/other-tools?keys=ESP8266+Certification+and+Test
http://bbs.espressif.com
http://www.espressif.com/en/products/hardware/esp8266ex/resources
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